Notes on Graphing

- All graphs must be created on a computer using Excel or some other graphing software.
- The graph must be properly labeled.
  - At the top of each graph there should be a label that gives the variables that are plotted, for example a distance versus time graph could be labeled as “distance vs. time” or just as “x vs. t”.
  - Each axis must be labeled and the units should be included in brackets. For the example of a distance x use the label: “x (m)”.
- When plotting y vs. x, the horizontal axis is x. All graphs must have a uniform scale along both axes. Always have the axes cross at the point (0,0).
- For any graph you must plot the **data points**, the **best-fit curve** and the **equation of the best-fit curve**.
- When using Excel always use the scatter plot format. Other formats will likely cause problems with maintaining a uniform scale.
  - Put the data in columns; if it is a graph of y vs. x, then the x column is on the left and y column is on the right. Highlight the data and then click the Insert tab. Then Chart > Scatter then choose the option “Scatter with only markers”.
  - Select the Layout tab to add the labels. To label Axes click “Axes Label” and appropriately label each axis. Labeling the graph is done with the “Chart Title” choice.
  - If the axis origin is not through (0,0) you can force it. Under the Layout tab click Axes, then choose which axis and then “More Primary Axis Options”, or more simply right-click the axis and choose “Format Axis”. Forcing the origin is done by choosing “Axis Options” > Minimum > Fixed > (0,0).
  - Now you must add the best-fit line or trendline. Right-click on a data point and choose “Add Trendline”. Choose “Trendline Options” and then Linear for the best-fit line and Polynomial > Order > 2 for a parabola. Always check “Display Equation on chart.”
  - The legend can be removed by right-clicking it and choosing delete.
  - The preceding directions are for Windows. On a Mac you have menus instead of the tabs. You choose a graph with Insert > Chart > “XY Scatter”. For the trendline right-clicking a data point behaves the same as Windows. Adding the labels requires using the Formatting Palette. (View > “Formatting Palette”). “Chart Options” > Titles will allow the labeling.

- **Example** - Here is a sample quadratic plot for the position vs. time data shown below. The data points are in the (t,x) format.

\[
\begin{align*}
(0.051, 1.311) \\
(0.504, 1.795) \\
(0.994, 3.718) \\
(1.480, 6.197) \\
(2.043, 9.723)
\end{align*}
\]

![Graph of x vs. t](attachment:image.png)

\[
y = 1.6184x^2 + 0.925x + 1.1476
\]
Electric Fields

Equipment and Setup: Mathematica file – ElectricFields.nb

Section A: Electric Fields Due to Two Charges

Computer Setup for Section A
1. The first interactive panel shows electric fields due to two point charges, $Q_1$ at $(-1 \text{ m}, 0)$ and $Q_2$ at $(1 \text{ m}, 0)$. The controls for this panel are at the top on the left.

2. The top line has two checkboxes: one to Show Axes and the other to Show Field Lines. The top line also has a slider labeled “Scale Factor”; this rescales the electric field vector arrows relative to the drawing. Click the checkboxes and move the slider to see what happens. To undo any changes, click the Reset button on the upper right of the panel.

3. The next line has buttons with three different values of the charges. Click these to see what happens.

4. The third line selects the point where the fields are evaluated. The five buttons give preset values for the $x$- and $y$-coordinates of this point. You can also drag the “locator” (crosshairs) to move the evaluation point to any position. Try this.

5. At the right of the control panel, the $x$- and $y$-components of the fields are shown. The vectors $\vec{E}_1$ and $\vec{E}_2$ are the electric fields due to $Q_1$ and $Q_2$, respectively; these are displayed with the green arrows in the picture. $\vec{E}$ is the total field, the vector sum of $\vec{E}_1$ and $\vec{E}_2$.

Data Recording for Section A
1. Select the charge configuration $Q_1 = -2 \mu C$ and $Q_2 = +2 \mu C$ (called a dipole) and check Show Axes. Drag the locator to move the evaluation position along the $y$-axis. In the space below, describe the direction of the field along the $y$-axis.

2. Select the second charge configuration ($Q_1 = -2 \mu C$ and $Q_2 = +3 \mu C$), check Show Axes and select the position $(0, 1 \text{ m})$. In the space below, record $\vec{E}_1$, $\vec{E}_2$ and $\vec{E}$. These electric field vectors will be calculated in a later question.

3. Select the third charge configuration ($Q_1 = -2 \mu C$ and $Q_2 = -3 \mu C$). With Show Axes checked drag the locator to a position along the $x$-axis between the two charges. Find the position where the electric field becomes zero. Record this position in the space below. (It suffices for the components to be less than $0.5 \times 10^3 \text{ N/C}$, which is sufficiently small compared to $\vec{E}_1$ and $\vec{E}_2$. ) This position will be calculated in a later question.
Section B: Trajectory of a Charged Particle in a Uniform Electric Field

Computer Setup for Section B
1. Now scroll down to the second interactive panel. This shows the paths of various charged particles that are shot into a region of uniform electric field. The field points left-right; a positive value of $E_x$ corresponds to a field to the right. The particle is shot in the $+y$-direction into this field with initial speed $v_0$.

2. At the top right are two buttons, a reset button and a U-shaped update button. The left of the control panel allows for the selection of the particle. The choices are: electron, proton, neutron, alpha particle and positron.

3. In the middle of the control panel you can choose the value of the initial speed $v_0$ and the electric field $E_x$. Anytime you change these values, you should then click the update button at the upper right.

4. There is also a checkbox to Animate Motion. Checking this box shows controls for animation. This may slow things down too much; if so, uncheck it.

5. The Exit Data is listed below the control panel.

Data Recording for Section B
Use $v_0 = 600,000 \text{ m/s}$ and $E_x = 15 \text{ N/C}$ for Steps 1 through 3 below.

1. Select the electron $e^-$ and record the exit data.

   $x_f = \underline{\quad} \text{ cm}, \quad y_f = \underline{\quad} \text{ cm}, \quad t_f = \underline{\quad} \text{ ns}$

2. Select the positron $e^+$ and record the exit data.

   $x_f = \underline{\quad} \text{ cm}, \quad y_f = \underline{\quad} \text{ cm}, \quad t_f = \underline{\quad} \text{ ns}$

3. Select the proton $p$ and record the exit data.

   $x_f = \underline{\quad} \text{ cm}, \quad y_f = \underline{\quad} \text{ cm}, \quad t_f = \underline{\quad} \text{ ns}$

4. Experiment with different values of $E_x$, keeping $v_0 = 600,000 \text{ m/s}$, to find the value needed for the proton to land at the same position as the electron (in Step 1). Record this value of $E_x$ below.

   $E_x = \underline{\quad} \text{ N/C}$

5. Experiment with different values of $v_0$, using $E_x = 15 \text{ N/C}$, to find the value of $v_0$ needed for the proton to land at the same position as the positron (in Step 2). Record below.

   $v_0 = \underline{\quad} \text{ m/s}$
Questions
A-1. Explain why the field of the dipole is perpendicular to the $y$-axis, as observed in Section A, Step 1.

A-2. Derive the result in Section A, Step 2.

A-3. Derive the result in Section A, Step 3. **Hint:** For the field $\vec{E}$ to be zero the vectors $\vec{E}_1$ and $\vec{E}_2$ must be equal in magnitude and opposite in direction. Since both charges are negative, the fields $\vec{E}_1$ and $\vec{E}_2$ point toward the corresponding charges. The only points where the fields are in opposite directions are points between the two charges on the $x$-axis. This gives:

$$k \frac{|Q_1|}{r_1^2} = k \frac{|Q_2|}{r_2^2}.$$ 

Use this equation to find the $x$-coordinate of the position where the net field is zero.
B-1. Compare the paths in Section B, Steps 1 and 2. Explain the differences and similarities.

B-2. Calculate the components of the acceleration vector $\vec{a}$ for both the electron and positron in Section B, Steps 1 and 2. **Record the acceleration of each particle in component form below.**

Electron: $\vec{a} =$ _________________________  Positron: $\vec{a} =$ _________________________

B-3. Calculate the speed of the electron as it leaves the screen in Section B, Step 1.

B-4. Why is the proton’s deflection in Section B, Step 3 so small?

B-5. Explain the results of Section B, Steps 4 and 5.
Electric Potential and Conductors

Equipment and Setup: Mathematica file – ElectricPotential.nb

Section A: Electric Potential Due to Two Charges

Computer Setup for Section A

1. The first interactive panel shows different representations of the electric potential due to two point charges: \( Q_1 \) at \((-1 \text{ m}, 0)\) and \( Q_2 \) at \((1 \text{ m}, 0)\). The buttons at the top left allow for choosing between three different sets of charges. The buttons at the top right gives a choice between two different ways to display the electric potential: the Interactive 2D Plot button shows equipotentials and electric field lines and \((x,y,V)\) Plot shows a 3D display of \( V \) as a function of \( x \) and \( y \), with the equipotentials drawn in. Click through to see both style displays for each set of charges. There is a small reset button at the upper right.

2. In the Interactive 2D Plot display there is a second set of controls that appear. There are three checkboxes: one to Show Axes, another to Show Field Lines and a third to Show \( \vec{E} \). The top line also has a slider labeled “\( \vec{E} \) Scale Factor”; this rescales the electric field vector arrows relative to the drawing. Click the checkboxes and move the slider to see what happens. To undo any changes here, click the other Reset button on the upper right of this inside panel. Note that holding the mouse over an equipotential gives its value in Volts.

3. The next line selects the point where the potentials are evaluated. The five buttons give preset values for the \( x \)- and \( y \)-coordinates of this point. You can also drag the “locator” (crosshairs) to move the evaluation point to any position. Try this.

4. At the right of the control panel, the electric potentials are shown. The values \( V_1 \) and \( V_2 \) are the electric potentials due to \( Q_1 \) and \( Q_2 \), respectively, and \( V \) is the sum of the two.

Data Recording for Section A

1. Select the charge configuration \( Q_1 = -2 \mu \text{C} \) and \( Q_2 = +2 \mu \text{C} \) (called a dipole) and check Show Axes. Drag the locator to move the evaluation position along the \( y \)-axis. Notice that the \( y \)-axis is the zero equipotential. View this in the \((x,y,V)\) Plot display as well.

2. Select the second charge configuration \((Q_1 = -2 \mu \text{C} \text{ and } Q_2 = +3 \mu \text{C})\), check Show Axes and select the position \((-1 \text{ m},-2 \text{ m})\). In the space below, record \( V_1 \) and \( V_2 \) and \( V \). These electric potentials will be calculated in a later question.
3. Continuing with the charge configuration \((Q_1 = -2 \, \mu C \text{ and } Q_2 = 3 \, \mu C)\), check Show Axes. Holding the mouse over the equipotentials identify the zero equipotential. Estimate the positions along the \(x\)-axis where the potential is zero. Dragging the locator along the equipotential may help in doing this. These positions will be calculated in a later question.

4. Select the third charge configuration \((Q_1 = -2 \, \mu C \text{ and } Q_2 = -3 \, \mu C)\). Are there any positions where the potential is zero?

**Section B: Point Charge Near a Conducting Sphere**

**Computer Setup for Section B**

1. Now scroll down to the second interactive panel. This shows a movable positive point charge, the blue dot, near a conducting sphere, the gray disk. The surface charge densities on the conducting sphere are shown in red for negative and blue for positive.

2. Moving from left to right along the top line of controls we find a slider that changes \(x_0\), the position of the point charge, the value of \(x_0\) and a pair of buttons that select between a neutral conductor, Zero Net Charge and a positively charged conductor, Positive Net Charge.

3. The second line of controls has three checkboxes and a slider. The Show Image Charges checkbox allows you to see the (hidden) trick used to draw these field and potential configurations; it is known as the Method of Images. We will not go deeper into this trick.

4. There is also a checkbox to Show \(F\) which shows the force vector on the point charge. The slider \(F\) Scale allows you to resize the vector when it becomes too large or small. The vector value of the force is shown to the right.

**Data Recording for Section B**

1. For the case of Zero Net Charge on the conductor vary the position and describe how the force changes. Describe how the surface charge densities change as well.
2. For the case of Positive Net Charge on the conductor vary the position and describe how the force changes and also describe how the surface charge densities change.

Questions

A-1. Explain why for the dipole the $y$-axis is the zero equipotential, as observed in Section A, Step 1.

A-2. Derive the result in Section A, Step 2.

A-3. Calculate the positions along the $x$-axis where the potential is zero. Compare this to what you found in Section A, Step 3.

A-4. Why is there nowhere, other than infinity, where the potential is zero in Section A, Step 4?
B-1. Applying Coulomb’s law $F = k \frac{|q_1||q_2|}{r^2}$ to the case of the neutral conductor, we have one positive charge, the point charge, and one zero charge, the conductor; this should give zero force, which is incorrect here. What is wrong with this naive application of Coulomb’s law here? Explain.

B-2. Explain why the force on the point charge should always be toward the neutral conductor.

B-3. For the case of the conductor with the Positive Net Charge, why should the force on the point charge be attractive when close and repulsive when far?
Ohm’s Law

**Equipment and Setup:** Circuit board, Multimeters (2)

**Using the Multimeter**

We will use a multimeter to measure voltage, current and resistance. The black lead to the multimeter should always be kept in the black socket. When using it as a voltmeter or Ohmmeter the red lead should be in the V-Ω socket. When using it as an ammeter the red lead should be set to one of the two ammeter sockets.

When making reading with a multimeter always use the lowest scale that reads. The number on the scale is the maximum reading of that scale. If there is a metric multiplier in a scale then you multiply the result by that multiplier. For example, if using an ammeter in the 200 mA scale the meter reads 153, then the result is 153 mA.

(A) Non-ohmic Behavior

Using a series circuit with both batteries, the rheostat and a light bulb demonstrate the non-ohmic behavior of a light bulb. Make a reading of voltage and current for each of five different setting of the rheostat. Use the 10 A setting on the ammeter to measure the current.

<table>
<thead>
<tr>
<th>Voltage across bulb $V$ (V)</th>
<th>Current through bulb $I$ (A)</th>
<th>$\frac{V}{I}$ (Ω)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Using software plot a graph of Voltage vs. Current.

**Question:** Does your graph show Ohmic behavior? Explain. Discuss why a light bulb should not be Ohmic.
Select two different resistors between 100 Ω and 1000 Ω. For each resistor make four measurements of voltage and current. Keep $R_1 < R_2$ and $R_2 < 3 R_1$. The diagrams above show how to get four different values of $V$ and $I$ for each of our two resistors. When measuring $V$ make sure you are measuring the voltage across just that resistor. Note that both currents in Trial 3 (and also for Trial 4) should be the same.

<table>
<thead>
<tr>
<th>Trial</th>
<th>Voltage across $R_1$ $V_1$ (V)</th>
<th>Current through $R_1$ $I_1$ (A)</th>
<th>Calculate $V/I$ ($\Omega$)</th>
<th>Voltage across $R_2$ $V_2$ (V)</th>
<th>Current through $R_2$ $I_2$ (A)</th>
<th>Calculate $V/I$ ($\Omega$)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Using software plot a graph of Voltage vs. Current for each resistor. There can be two separate graphs or both plots could be on the same graph. For each resistor plot the best-fit line, the equation of the best-fit line and find its slope. Compare the slopes with the resistances. Give the percent errors.
(C) Variation of Current with Resistance for Fixed Voltage

Select an additional two different resistors between 100 Ω and 1000 Ω. Use a single battery and just one resistor at a time. The voltage of the battery is the Fixed Voltage. Measure the current through each resistor.

Fixed Voltage = ________________

<table>
<thead>
<tr>
<th>Resistance $R$ (Ω)</th>
<th>Current $I$ (A)</th>
<th>Resistance$^{-1}$ $1/R$ (Ω$^{-1}$)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Using software plot a graph of Current vs. $1/R$. Plot the best-fit line, the equation of the best-fit line and find its slope. Compare the slope with the Fixed Voltage and give the percent error.
Series and Parallel Circuits

Equipment and Setup: Circuit board, Multimeters (2)

The three circuits we will consider are series, parallel and series-parallel.

Recall that when measuring voltage across something, the voltmeter should be connected in parallel with it. When measuring current through something, the meter should be placed in series with it. (Suggestion: When measuring the current through a resistor it is sometimes difficult to isolate that resistor for the measurement. To do this, remove one end of the resistor and put the meter between the loose end and its connection.)

Procedure

Select three resistors, in increasing order, between 100 Ω and 1000 Ω. From the stripes on the resistors, read the listed values of their resistances. Compare with the measured values obtained from the multimeter, set as an Ohmmeter.

<table>
<thead>
<tr>
<th>Listed Values (from stripes)</th>
<th>Measured Values (from meter)</th>
<th>% Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>$R_1$</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$R_2$</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$R_3$</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use the same battery for each part of this experiment. Measure the voltage across this battery. Call this the Source Voltage.

Source Voltage: $V_S = \phantom{}$

Use the Source Voltage in all your theoretical calculations of current and voltage. Also use the listed values of the resistances for all calculations.
(A) Series Circuit

Connect the three resistors in series, measure their equivalent resistance and compare with the theoretical value. Use the listed values in your calculations.

<table>
<thead>
<tr>
<th>Equivalent Resistance: $R_{eq}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theoretical Value (from calculation)</td>
</tr>
<tr>
<td>----------------------------------</td>
</tr>
</tbody>
</table>

Calculation (show work)

Connect this series arrangement across a single battery. Measure the current and the voltages across each resistor.

<table>
<thead>
<tr>
<th>Total Current: $I_{tot}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theoretical Value (from calculation)</td>
</tr>
<tr>
<td>--------------------------</td>
</tr>
<tr>
<td>Voltage Across $R_1$: $V_1$</td>
</tr>
<tr>
<td>Voltage Across $R_2$: $V_2$</td>
</tr>
<tr>
<td>Voltage Across $R_3$: $V_3$</td>
</tr>
</tbody>
</table>

Calculations (show work)

Find the sum of the measured voltages: $V_1 + V_2 + V_3 = \underline{\quad}$

Compare this with the Source Voltage. % difference = \underline{\quad}
(B) Parallel Circuit

Connect the three resistors in parallel, measure their equivalent resistance and compare with the theoretical value. Use the listed values in your calculations.

<table>
<thead>
<tr>
<th>Equivalent Resistance: $R_\text{eq}$</th>
<th>Theoretical Value (from calculation)</th>
<th>Measured Value (from meter)</th>
<th>% Error</th>
</tr>
</thead>
</table>

Calculation (show work)

Connect this parallel arrangement across a single battery. Measure the total current and the currents through each resistor.

<table>
<thead>
<tr>
<th>Total Current: $I_\text{tot}$</th>
<th>Theoretical Value (from calculation)</th>
<th>Measured Value (from meter)</th>
<th>% Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Through $R_1$: $I_1$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Through $R_2$: $I_2$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Through $R_3$: $I_3$</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Calculations (show work)

Find the sum of the measured currents:

\[ I_1 + I_2 + I_3 = \text{_____________} \]

Compare this with the measured Total Current, $I_\text{tot}$.

\[ \% \text{ difference} = \text{_____________} \]
(C) Series-Parallel Circuit

Connect $R_2$ and $R_3$ in parallel and then connect this in series with $R_1$. Measure their equivalent resistance and compare with the theoretical value. Use the listed values in your calculations.

<table>
<thead>
<tr>
<th>Equivalent Resistance: $R_{eq}$</th>
<th>Theoretical Value (from calculation)</th>
<th>Measured Value (from meter)</th>
<th>% Error</th>
</tr>
</thead>
</table>

Calculation (show work)

Connect this arrangement across a single battery. Measure the currents through each resistor and the voltages across each resistor.

<table>
<thead>
<tr>
<th>Current Through $R_1$: $I_1 = I_{tot}$</th>
<th>Theoretical Value (from calculation)</th>
<th>Measured Value (from meter)</th>
<th>% Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Through $R_2$: $I_2$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Through $R_3$: $I_3$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage Across $R_1$: $V_1$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage Across $R_2$ &amp; $R_3$: $V_2 = V_3$</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Calculations (show work)
Find the sum of the measured voltages: \( V_1 + V_2 = \) _______________

Compare this with the Source Voltage. \( \% \) difference = _______________

Find the sum of the measured currents: \( I_2 + I_3 = \) _______________

Compare this with the measured current through \( R_1 \), \( I_1 = I_{\text{tot}} \). \( \% \) difference = _______________

**Question 1**  Suppose the resistors in the various circuits were light bulbs. When a bulb burns out it becomes a break in the circuit: this is equivalent to an infinite resistance. In each of the three circuits used, what happens to one bulb when another burns out. Specify whether the bulb goes dark, stays the same brightness, burns brighter or burns more dimly. Assume the battery is an ideal source with no internal resistance.

(a) If a bulb in the series circuit of part (A) burns out, what happens to the other bulbs.

(b) If a bulb in the parallel circuit of part (B) burns out, what happens to the other bulbs.

(c) If in the series-parallel circuit of part (C) if the bulb for \( R_2 \) burns out, what happens to \( R_1 \) and \( R_3 \)?

**Question 2**  Show that there are 17 different equivalent resistances that can be formed using three resistors. (Use one of three, two of three or all three.)
Charged Particles in Electromagnetic Fields

Equipment and Setup: Mathematica file – CrossedFields.nb

Background

Motion of a Charged Particle in a Uniform Magnetic Field

Consider a particle with mass $m$ and charge $+q$ moving with velocity $\vec{v}$ in a region of uniform magnetic field $\vec{B}$ directed into the page, as shown in Figure 1.

The magnitude of the magnetic force on the particle is given by:

$$F_{\text{mag}} = |q|vB \sin \theta,$$

in which $\theta$ is the angle between $\vec{v}$ and $\vec{B}$. In the situation shown in Fig. 1, $\theta = 90^\circ$, so:

$$F_{\text{mag}} = |q|vB \sin 90^\circ = |q|vB$$

The magnetic force vector $\vec{F}_{\text{mag}}$ always points perpendicular to both $\vec{v}$ and $\vec{B}$, as shown in Fig. 1. Its direction is given by the “right-hand rule”. Applying Newton’s second law to the centripetal direction in Fig. 1 gives the following expression for the radius of the circular path in which the particle moves:

$$r = \frac{mv}{|q|B}$$
The Velocity Filter
The velocity filter, also called a velocity selector, is a device for “filtering out” of a beam of particles all those except particles which have a certain chosen speed. Figure 2 below shows a diagram of a velocity filter. As shown in Fig. 2, a velocity filter consists of a parallel-plate capacitor placed in a region of uniform magnetic field. If the dimensions of the plates of the capacitor are large compared to the distance between the plates, the electric field produced by the capacitor will be approximately uniform and will point from the positively charged plate to the negatively charged plate, as shown in the figure.

Now suppose a positively charged particle moves into the velocity selector with a speed $v$, as shown in Fig. 2. The particle will experience an electric force of magnitude

$$F_{elec} = |q|E$$

and a magnetic force of magnitude

$$F_{mag} = |q|vB \sin 90^\circ = |q|vB.$$ 

The direction of the electric force is downward, in the direction of $\vec{E}$, since the particle is positively charged. By the right-hand rule, the direction of the magnetic force is upward.

If the net force on the particle is zero, it will pass through the velocity selector undeflected. In order for this to happen, the magnetic and electric forces must be equal in magnitude:

$$F_{mag} = F_{elec}$$

$$|q|vB = |q|E$$

Thus the speed for which the particle goes through undeflected is:

$$v = \frac{E}{B} \quad (5)$$

Particles with this speed will make it through the slit shown at the right end of the velocity selector in Fig. 2. Particles with speeds greater than or less than $E/B$ will be blocked by the screen. By adjusting $E$ and $B$, we can select the velocity of the particles we want to let through.

Computer Setup
1. The interactive panel shows the paths of various charged particles that are shot into a region of uniform electric field and uniform magnetic field. The electric field points left-right; a positive value of $E_x$ corresponds to a field to the right. The magnetic field points out of the screen or into the screen; a positive value of $B_z$ corresponds to a magnetic field pointing out of the screen. The particle is shot in the $+y$-direction with initial speed $v_0$. 

![Figure 2](image-url)
2. At the top right are two buttons, a reset button and a U-shaped update button. The left of the control panel allows for the selection of the particle. The choices are: electron, proton, neutron, alpha particle and positron.

3. In the middle of the control panel you can choose the value of the initial speed $v_0$, the electric field $E_x$, and the magnetic field $B_z$. Anytime you change these values, you should then click the update button at the upper right. Note that the magnitudes of the fields $B$ and $E$ are the absolute values of $B_z$ and $E_x$.

4. In the middle there is also a checkbox to Animate Motion. Checking this shows controls for animation. If you get a dialog box that says “Dynamic Content Warning”, click “Enable Dynamic”. Enabling animation may slow things down too much; if so, uncheck the checkbox.

5. The Exit Data is listed below the control panel.

**Data Recording for Section A**

**Data Recording**

**Section A: Electron in Uniform Magnetic Field**

1. Use $v_0 = 600,000\text{ m/s}$, $E_x = 0$ and $B_z = -0.00015\text{ T}$. Select the electron $e^-$ and record the exit data.

\[ x_f = \underline{\text{__________}}\text{ cm}, \quad y_f = \underline{\text{__________}}\text{ cm}, \quad t_f = \underline{\text{__________}}\text{ ns} \]

**Questions**

A-1. What is the direction of the magnetic force on the electron as it enters the field?

A-2. Calculate the radius of the circular path from the initial data and compare with the exit data. **Show your work in the space below.**

A-3. Which way (into the screen or out of the screen) should the magnetic field be directed in order to make the electron go counter clockwise? (Circle your answer.)

a) into the screen

b) out of the screen

A-4. Referring to Eq. (3), calculate the magnitude of the magnetic field (in teslas) needed to cause the electron with $v_0 = 600,000\text{ m/s}$ to move in a counterclockwise circular path of radius 4 cm. **Show your work in the space below.**
Section A: Electron in Uniform Magnetic Field (cont’d)

2. We want the electron to move in a counterclockwise circle of radius 4 cm. Use the results of Questions A-3 and A-4 to do this, remembering that the sign of $B$ gives the direction of the $B$-field. If the radius of the path is not 4 cm, review your calculation in Question A-4, if necessary, to correct any errors. Record the exit data.

\[ x_f = \text{______________ cm}, \quad y_f = \text{______________ cm}, \quad t_f = \text{______________ ns} \]

Section B: Positron in Uniform Magnetic Field

1. Now keep all values set as they are (after A.2) but select the positron $e^+$ instead of the electron. The positron is the antiparticle of the electron. Record the exit data.

\[ x_f = \text{______________ cm}, \quad y_f = \text{______________ cm}, \quad t_f = \text{______________ ns} \]

Questions
B-1. Describe and explain the similarities and differences between the electron and positron paths.

Section C: Alpha Particle in Uniform Magnetic Field

1. Use $v_0 = 600,000 \text{ m/s}$, $E_z = 0$ and $B_z = -0.00015 \text{ T}$. Select the alpha particle $\alpha$ and record the exit data.

\[ x_f = \text{______________ cm}, \quad y_f = \text{______________ cm}, \quad t_f = \text{______________ ns} \]

2. Section C is similar to Section A. This time, though, the particle is an alpha particle (a helium nucleus). You are to use a magnetic field to cause the alpha particles to move clockwise in a semicircular path of approximately 4-cm radius. You should not use an electric field. Before proceeding, answer Question C-1 below.

Questions
C-1. Which way (into the screen or out of the screen) should the magnetic field be directed? (Circle your answer.)

a) into the screen
b) out of the screen
Section C: Alpha Particle in Uniform Magnetic Field (cont’d)

3. Now experiment with changing the magnetic field until you get the alpha particles to move clockwise in a semicircle of 4-cm radius. When you are successful, record your value of the magnetic field magnitude \( B \) in teslas in the space below.

\[
B = \underline{\underline{\text{T}}} 
\]

Section D: Electric and Magnetic Fields I

1. Use \( v_0 = 600,000 \text{ m/s}, \ E_x = 20 \text{ N/C} \) and \( B_z = -0.00015 \text{ T} \). Select the positron \( e^+ \). With an electric field in the \( x \)-direction and magnetic field in the \( z \)-direction a charged particle moving in the \( x-y \) plane will stay in that plane. With this choice of parameters an odd motion is observed. Sketch the trajectory in the space below.

Questions

D-1. Consider two positions in the trajectory: a point we will refer to as \( L \) at the far left, where the radius of curvature is the smallest, and a point \( R \) at far right where the radius of curvature is largest. Draw these points and label them in the above diagram. For each of these points, draw vectors showing the directions of the electric and magnetic forces \( \vec{F}_{\text{elec}} \) and \( \vec{F}_{\text{mag}} \).

D-2. Of the two positions \( L \) and \( R \), where is the speed the largest? Explain. Hint: Consider the electric potential energy and remember that electric field lines point toward lower potential. Also remember that magnetic forces do no work and therefore cannot change the speed. Answer in the space below.
Section E: Electric and Magnetic Fields II – The Velocity Filter

1. Here we will set up a velocity filter as discussed in the theory section. Use $v_0 = 600,000 \text{ m/s}$, $B_z = 0.0002 \text{ T}$, and select the electron $e^-$. 

Questions

E-1. Which direction (left or right) should the electric field point in order for the velocity filter to work properly? (Circle your answer.)
   a) to the left
   b) to the right

E-2. Given the above values of $v$ and $B$, calculate the value $E$ required for particles to go through without being deflected. **Show work in the space below.**

Section E: Electric and Magnetic Fields II – The Velocity Filter (cont’d)

2. Input the appropriate value of $E_x$, being careful about the sign.

3. Record $x$ from the Exit Data for the electron.

   **Exit Data:** $e^-: x_f = \text{ cm}$

4. Now try the rest of the particles (proton, neutron, alpha particle and positron) and record their exit values.

   **Exit Data:**
   
   $p: x_f = \text{ cm}$
   $n: x_f = \text{ cm}$
   $\alpha: x_f = \text{ cm}$
   $e^+: x_f = \text{ cm}$
Additional Questions (can be answered outside of class)

1. In the space below, give a derivation of Eq. (3). **Hint:** Apply Newton’s second law to the centripetal direction:

\[ (\sum F)_{cp} = ma_{cp} \]

2. In Section A, what happens to the speed of an electron as it moves in its semicircular path? **Explain.**

3. In Section C, do you need a larger or smaller \( B \)-field magnitude than in Section A? **Explain.**

Calculate the \( B \)-field needed in Section C and compare this with the value of \( B \) you found in Step 3 of Section C. Calculate the percent error. **Show your work in the space below.**
Induction – Magnet Through a Coil

Equipment and Setup: Voltage probe, Solenoid, Bar magnets (2), Capstone file – Induction.cap

Background
When a magnet is passed through a coil there is a changing magnetic flux through the coil. This induces an \( \text{emf} \) (electro-motive force) \( \varepsilon \) in the coil. According to Faraday’s Law of Induction:

\[
\varepsilon = -N \frac{d\Phi}{dt}.
\]

Use the voltage sensor to measure the voltage (\( \text{emf} \)) induced in a solenoid as a bar magnet moves through the solenoid. A plot of the voltage versus time is made and the area under the curve is found by integration. This area (\( \varepsilon\times t \)) is proportional to the magnetic flux since:

\[
\int \varepsilon \, dt = -N \Delta \Phi.
\]

Setup and Data Recording

1. Connect the red lead of the voltage probe to the top terminal of the solenoid and the black to the bottom. A positive voltage corresponds to the top terminal being at higher voltage.
2. Hold the magnet so that the north end is a few centimeters above the solenoid.
3. Start recording (press rec) just before dropping the magnet through solenoid. Stop recording after the magnet falls through. It will shut off automatically after 5 seconds but stopping earlier will help.
4. The data from the voltage sensor should be recorded automatically on the graph.
5. Click the selection tool and reposition and resize it to cover one of the peaks. Click the area tool and record the area. Do the same for the other peak.
6. Ignoring the signs, calculate the percent differences for the two areas.
7. Sketch the shape of your graph in the space to the right of the data. Pay close attention to any similarities or differences in the two peaks.
8. Repeat this procedure for each case listed in the data sheet.
Data Sheet

A. Look at the way the coil is wrapped. If a current passes through the solenoid from the bottom to the top, is the current clockwise or counterclockwise when viewed from above? The sense of an emf (clockwise or counterclockwise) corresponds to the sense of its induced current. An emf pushing from the bottom to the top will record as a positive voltage.

B. Drop one magnet through the solenoid with the north pole on the bottom. Record the value of integration for first peak, the value of integration for the second peak and the percent difference. To the right of the table give a crude sketch of the graph that is shown.

<table>
<thead>
<tr>
<th>Area</th>
<th>First Peak (V·s)</th>
<th>Second Peak (V·s)</th>
<th>% Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clockwise or Counterclockwise</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

C. Drop one magnet through the solenoid with the south pole on the bottom. Record the value of integration for first peak, the value of integration for the second peak and the percent difference. To the right of the table give a crude sketch of the graph that is shown.

<table>
<thead>
<tr>
<th>Area</th>
<th>First Peak (V·s)</th>
<th>Second Peak (V·s)</th>
<th>% Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clockwise or Counterclockwise</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

D. Drop two magnets through the solenoid taped together so that both south poles are together and at the bottom. Record the value of integration for first peak, the value of integration for the second peak and the percent difference. To the right of the table give a crude sketch of the graph that is shown.

<table>
<thead>
<tr>
<th>Area</th>
<th>First Peak (V·s)</th>
<th>Second Peak (V·s)</th>
<th>% Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clockwise or Counterclockwise</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Questions

1. Is the incoming (first peak area) flux equal in magnitude to the outgoing (second peak area) flux? Should they be equal? Explain.

2. The two peaks do not have exactly the same shape. Explain how they are different and why?

3. Why are the peaks in opposite directions?

4. Use Lenz’s law to theoretically explain the sense of the induced \( emf \) as a magnet with its North pole down as the magnetic first enters and then leaves the solenoid.

5. Suppose an isolated magnetic North pole is discovered and dropped through this setup. Describe the voltage pattern by giving a crude sketch of the voltage as a function of time.
RC Circuits

Equipment and Setup:  RC circuit board, Voltage probe, Capstone file – RC circuits.cap

We will study charging and discharging capacitors. The characteristic time for charging or discharging a capacitor is called the time constant \( \tau = RC \). The charge on the capacitor and the voltage across it are related by \( V = Q/C \). A fully charged capacitor will have charge \( Q_{\text{max}} = CV_S \). The charge and voltage for charging and discharging capacitors are given by:

\[
Q(t) = Q_{\text{max}} \left(1 - e^{-t/\tau}\right) \quad \text{and} \quad V(t) = V_S \left(1 - e^{-t/\tau}\right) \quad \text{for charging}
\]

\[
Q(t) = Q_{\text{max}} e^{t/\tau} \quad \text{and} \quad V(t) = V_S e^{-t/\tau} \quad \text{for discharging}
\]

where we are assuming that the capacitor is fully charged before it is discharged and fully discharged before it is charged. (Hint: To fully charge or discharge the capacitor set the switch appropriately and short out the resistor; this reduces the time constant and thus speeds up the process.)

Procedure

(1) Connect the voltage probe across the capacitor and put a wire between the capacitor and resistor to complete the circuit.

(2) Measure the source voltage \( V_S \).

(3) Calculate the theoretical value of the time constant, \( \tau = RC \).

(4) Charge the capacitor and record 12 of the voltage values. Choose times that illustrate the proper functional behavior; include a few time constants in your data.

(5) Using Software, plot a graph of \( \ln(V_S - V) \) vs. time. Include the best-fit line and its equation.

(6) From the slope find the experimental value of the time constant. In theory the slope should be \(-1/\tau\), so the experimental value of the time constant is: \( \tau_{\text{exp}} = -1/\text{slope} \).

(7) Discharge the capacitor and record 12 of the voltage values. As before choose times that illustrate the proper functional behavior.

(8) Using Software, plot a graph of \( \ln V \) vs. time. Include the best-fit line and its equation.

(9) From the slope find the experimental value of the time constant. In theory the slope should also be \(-1/\tau\), so the experimental value of the time constant is: \( \tau_{\text{exp}} = -1/\text{slope} \). Average the two experimental values of the time constant (one from charging and one from discharging) and compare with the theoretical value. Give the percent error.

(10) Add a second capacitor in parallel with the first. The new capacitance is the sum of the two. Repeat steps (3) through (9) with the new time constant.
**Data Table**

Source Voltage = $V_S =$ ______________________

<table>
<thead>
<tr>
<th></th>
<th>Trial 1</th>
<th>Trial 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>$R =$</td>
<td>_______________</td>
<td>$R =$ __________</td>
</tr>
<tr>
<td>$C =$</td>
<td>_______________</td>
<td>$C =$ __________</td>
</tr>
<tr>
<td>$\tau =RC =$</td>
<td>_______________</td>
<td>$\tau =RC =$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Charging</th>
<th>Discharging</th>
<th>Charging</th>
<th>Discharging</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Voltage</td>
<td>Time</td>
<td>Voltage</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Slope = __________ Slope = __________ Slope = __________ Slope = __________

$\tau_{exp}$ = __________ $\tau_{exp}$ = __________ $\tau_{exp}$ = __________ $\tau_{exp}$ = __________

Average $\tau_{exp}$ = ______________ Average $\tau_{exp}$ = ______________

% Error = ______________ % Error = ______________
The Series RLC Circuit

Equipment and Setup: RCL circuit board, Multimeter, Banana leads (one black, one red), Voltage probe, Capstone file – RLC scope.cap

Preliminary calculations

On the RLC circuit card identify the following components:

\[ R = 10 \ \Omega \quad L = 8.2 \text{ mH} \quad C = 100 \ \mu\text{F} \]

Use a multimeter with banana leads to measure the internal resistance, \( r \), of the inductor. Put the multimeter away, you won’t need it again.

Resistance of Inductor: \( r = \) _______________ \( \Omega \)

Total resistance of circuit: \( R_{eq} = \) _______________ \( \Omega \)

Calculate the theoretical values of the reactance and impedance of the system given \( f = 120 \text{ Hz} \). Remember to use \( R_{eq} \) to calculate the impedance.

\[ X_L = \quad \Omega \quad X_C = \quad \Omega \quad Z = \quad \Omega \]

Show work.

Placement of Voltage Probe in Procedure

Parts A.10, B

black lead red lead

red lead black lead

red lead black lead

Parts A.9

Part A.11

Parts A.2–A.8, C

Placement of Voltage Probe in Procedure
(A) Voltage, Current, and Impedance

Procedure

You will connect a variable frequency AC source across a series RLC circuit, and compare measurement of peak current, peak voltages, and phase angles to expected values.

(A.1) Turn on the Pasco 850 interface and open the Capstone file on your computer.

(A.2) Using banana leads, connect output 1 on the Pasco interface (upper far right on interface) across the chosen RLC circuit (black lead from ground to base of 10Ω resistor, red lead from red output to base of 100 µF capacitor.) Keep this connection unchanged for the rest of the experiment.

(A.3) Connect the voltage probe to Analog Input A on the interface. Connect the leads of the voltage probe across the input voltage on the RLC circuit card (into the backs of the leads that are already there.)

(A.4) On the capstone display, click Signal Generator (on left). Change the frequency to 120 Hz. Click “on” to turn the generator on.

(A.5) Monitor the signal for a second or so.

(A.6) On the dual trace oscilloscope display, identify the voltage trace and the current trace. Use the Data Selection tool to measure the peak voltage (amplitude) of the source. Record the peak voltage, \( V \).

Peak source voltage: \( V \) ________________

(A.7) Measure the peak current and record this as the experimental value of current, \( I \). (Note: the ammeter is inside the Pasco interface, so it will always record the system current, not the probe current.) Record this as the experimental current in the table that follows the instructions.

(A.8) Phase analysis: Look at the two peaks, does voltage lead (peak earlier) or lag (peak later) than current.

Does the voltage lead, lag or is it in phase with the current? (circle one) lead, lag, in phase

Measure the time difference (magnitude) between the voltage peak and the nearest current peak. Be sure to measure the time to at least 3 significant figures.

\[ \Delta t = \] ________________

Compute the phase angle between the source voltage and the current, \( \phi = -\omega \Delta t \), and record this in the table that follows.

(A.9) Leaving the source voltage connected as is, move the voltage probe leads to measure the peak voltage across the resistor alone, leaving the black lead connected to the black lead from the source. Record this as the experimental value in the table that follows.

Phase analysis: Look at the two peaks displayed. \( V_R \) and \( I \)

Does the voltage lead, lag or is it in phase with the current? (circle one) lead, lag, in phase

By how much is the lead or lag? (circle one) 0 (in phase), \( \frac{\pi}{2} \) rad, by less than \( \frac{\pi}{2} \) rad
(A.10) Leaving the source voltage connected as is, move the voltage probe leads to measure peak voltage across the inductor alone, with the black lead closer to the “ground” (black) of the source. Record the peak voltage on your table. Look at the two peaks displayed. $V_{Lr}$ and $I$.

Does the voltage lead, lag or is it in phase with the current? (circle one) lead, lag, in phase

By how much is the lead or lag (circle)? by 0 (in phase), by $\frac{\pi}{2}$ rad, by less than $\frac{\pi}{2}$ rad

(A.11) Leaving the source voltage connected as is, move the voltage probe leads to measure peak voltage across the capacitor alone, with the red lead connected to the red lead from the source. Record the peak voltage on your table. Look at the two peaks displayed. $V_C$ and $I$

Does the voltage lead, lag or is it in phase with the current? (circle one) lead, lag, in phase

By how much is the lead or lag (circle)? by 0 (in phase), by $\frac{\pi}{2}$ rad, by less than $\frac{\pi}{2}$ rad

Data table:

<table>
<thead>
<tr>
<th>Amplitude (peak value)</th>
<th>Experimental</th>
<th>Theoretical</th>
<th>% Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>$I$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$V_R$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$V_{Lr}$</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$V_C$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\phi$</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Analysis: Compute the theoretical values and percent errors. *Show Work on a separate sheet.* Begin with the measured value of the peak source voltage $V$ for theoretical calculations.

*Remember the inductor has resistance, for $V_{Lr}$ you will need to compute the impedance $Z_{Lr}$ for the inductor with its internal resistance.*

Recall: $\text{percent error} = \left| \frac{\text{exp-theo}}{\text{theo}} \right| \times 100\%$
**Question A.1:** Do the peak values add up to the peak value of the source, that is, does $V = V_R + V_{Lr} + V_C$? Should they add this way? Explain why or why not.

**Question A.2:** Using your theoretical results, find the average power dissipated in this circuit. (Remember that we are measuring the peak values (amplitudes) and not the rms values.) Show work.

**Question A.3:** Look at the phase differences in the resistor, inductor, and capacitor. Are they what you expected? Discuss these phase differences and why they should look as they do.

- between $V_R$ and $I$: 

- between $V_{Lr}$ and $I$: 

- between $V_C$ and $I$: 

(B) Inductor with Ferromagnetic Core

(B.1) Unclip the iron core from your RLC circuit card and insert it into the center of the inductor. This will change the inductance to an unknown value.

(B.2) Measure the peak current in the system and peak Voltage across the inductor.

\[ I = \text{___________________} \quad V_{lr} = \text{___________________} \]

(B.3) Calculate the new value of the inductance. *Show your work on a separate sheet of paper or on the back of this sheet. This is the reverse of the calculation of \( V_{lr} \) in part A.*

with core: measured value \( L = \text{___________________} \) H

(C) Resonance

(C.1) Leave the iron core in place. Set your voltage probe to measure the Source voltage. Click monitor and leave it on. Note: you can adjust the size of the displays separately by grabbing and dragging at axes on left or right respectively.

(C.2) With the signal generator open in Capstone, adjust the frequency until the Voltage and current peaks occur at the same time, that is \( V \) and \( I \) are in phase. Your circuit is now in resonance. Record this frequency.

Experimental resonance frequency \( f_0 \) \( \text{___________________} \) Hz

A more accurate way to find the resonance frequency is to display current \( I \) on the vertical axis while displaying source voltage \( V \) on the horizontal axis. This will result in an oval shaped figure called a lissajous.

The plot is \( V = V_{max} \cos(\omega t + \phi) \) vs. \( I = I_{max} \cos(\omega t) \). At resonance, the phase angle, \( \phi = 0 \), and the lissajous appears to collapses into the form of a line.

(C.3) Put your source (from channel 1 Output) and the voltage probe across the following series RLC circuit:

(C.4) Turn off the Signal generator. Select “x-y scope” tab (top, left). Click signal generator and turn it on.

(C.5) Turn on monitoring and adjust the frequency of the Signal Generator until the lissajous on the oscilloscope display collapses into a straight line. Because this is more accurate than the previously measure value, refer to this as the accepted value of the resonance frequency.

Accepted resonance frequency \( f_0 = \text{___________________} \) Hz \quad % error \text{___________________}

Using this accepted resonance frequency, compute the accepted value of the inductance. Record this as the theoretical value of inductance. Compare the measured value of inductance found in part (B) to this accepted value.

Accepted inductance value (with core) \( L = \text{___________________} \) H \quad % error \text{___________________}

Show work:
**Geometric Optics and the Ray Box**

**Equipment and Setup:** Light source, Optical component set, Ruler, Protractor

The ray box can be used to get parallel rays of light from a source. For each part sketch the rays and components on a plain piece of paper. Sketch the components (mirrors and lenses) by tracing them with a pencil and draw the rays by marking two points on the ray with a pencil and then use a straight edge between the points to trace each line.

(A) **Reflection from a Concave Mirror**

Use three rays and a concave mirror. Align the central ray with the pre-drawn line and focus the rays to a point along the central axis. Trace the incident rays, the reflected rays and the mirror. Use the drawing to find the focal length of the mirror.

\[ f = \_\_\_\_\_\_\_\_\_\_\_\_\_ \]

(B) **Reflection from a Convex Mirror**

Use three rays and a convex mirror. Align the central ray with the pre-drawn line. Trace the incident rays, the reflected rays and the mirror. Extend the reflected rays backward to find where they intersect. Use the drawing to find the focal length of the mirror.

\[ f = \_\_\_\_\_\_\_\_\_\_\_\_\_ \]
(C) Double-convex (Converging) Lens

Use three rays and a double-convex lens. Align the central ray with the pre-drawn line and place the lens so that its center is along the pre-drawn perpendicular line. Focus the rays to a point along the central axis. Trace the incident rays, the refracted rays and the lens. Use the drawing to find the focal length of the lens. (Measure the distance from the center of the lens.)

\[ f = \text{__________} \]

(D) Double-concave (Diverging) Lens

Use three rays and a double-concave lens. Align the central ray with the pre-drawn line and place the lens so that its center is along the pre-drawn perpendicular line. The rays should diverge from the central axis. Trace the incident rays, the refracted rays and the lens. Extend the refracted rays backward to find the focal length of the lens. (Measure the distance from the center of the lens.)

\[ f = \text{__________} \]

(E) Snell's Law

Use one ray and a prism with a 30° apex angle. Align the ray with the pre-drawn line and one face of the prism with the perpendicular. This makes the incident angle equal to the apex angle of the prism: \( \theta_1 = 30° \). \( n_1 = n \) is the unknown index of the prism and \( n_2 = 1 \) is the index of air. Draw the refracted ray (the ray leaving the prism) and measure the total angle of deflection \( \delta \). \( \delta \) is related to \( \theta_2 \) by: \( \theta_2 = 30° + \delta \).

\[ \delta = \text{__________} \quad \theta_2 = \text{__________} \]

Using Snell’s Law \( n_1 \sin \theta_1 = n_2 \sin \theta_2 \) calculate \( n \), the index of the prism.

\[ n = \text{__________} \]
(F) Plano-convex (Converging) Lens

Use three rays and the plastic lens with one flat face and one semicircular face. Align the flat face with the pre-drawn perpendicular line and the central ray with the long line. Trace the rays and the lens. From the diagram measure the focal length of the lens. (The distance is measured from the curved face.) Measure the radius of the lens.

\[ f = \text{______} \quad R = \text{______} \]

The lensmaker’s equation \( \frac{1}{f} = (n - 1) \left[ \frac{1}{R_1} - \frac{1}{R_2} \right] \) relates the radii of curvature of the faces of a thin lens and its index of refraction to the lens’ focal length. In this expression the radii are measured from the side of the refracted ray. For this plano-convex lens we have: \( R_1 = \infty \) (a flat face) and \( R_2 = -R \). Plugging this into the lensmaker equation we get:

\[ \frac{1}{f} = (n - 1) \left( \frac{1}{0} - \frac{1}{R} \right) \quad \Rightarrow \quad \frac{1}{f} = (n - 1) \left( 0 + \frac{1}{R} \right) \quad \Rightarrow \quad n = 1 + \frac{R}{f}. \]

Use this to find the lens’ index of refraction.

\[ n = \text{______} \]

(G) Total Internal Reflection

Use one ray and the plano-convex lens from part (F). Align the flat face with the pre-drawn perpendicular line and the ray with the long line. Slide the flat face of the lens along the perpendicular until you reach the critical position where the refracted ray disappears. At that position carefully trace the curved face of the lens. Now the incident angle is the critical angle: \( \theta_1 = \theta_{\text{crit}} \). Solve for this critical angle by measuring \( d \) (as shown) and by using \( \cos \theta_1 = \frac{d}{R} \). Use this and \( \sin \theta_{\text{crit}} = \frac{n_2}{n_1} = 1/n \) to find the index of refraction of the lens.

\[ d = \text{______} \]

\[ \theta_1 = \theta_{\text{crit}} = \text{______} \]

\[ n = \text{______} \]